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Introduction

Your new device is not simply a conventional copier, it is a digital device capable of copying, faxing,
printing and scanning, dependent on your model and configuration.

There are two configurations available:

e  WorkCentre Copier/Printer - A multi-functional digital device capable of copying, printing, faxing
(optional), e-mailing and network scanning (optional).

e  WorkCentre Copier/Printer/Scanner - An advanced multi-functional device offering a high
specification of features and functions. This model is capable of copying, printing, scanning, e-
mailing and faxing (optional).

Each model has seven configurations available which provide either 35, 40, 45, 55, 65, 75 or 90
copies/prints a minute. All configurations are fully upgradable so as to meet any future requirements
you may have. Please contact your local Xerox representative for further information.

For further assistance in identifying your model, configuration and the additional options available
please refer to on page 5.

All features and functions described within the User Guide relate to a fully configured WorkCentre and
may not be available on your device. If you require further information on any of the optional
components, or information on any of the other device configurations please contact your local Xerox
representative.

If you need assistance during or after product installation, please visit the Xerox website for online
solutions and support.

If you require further assistance, call our experts at the Xerox Support Center, or contact your local
representative. When telephoning please quote the machine serial number. Use the space below to
make a note of the machine serial number:

#

To access the serial number open the front door. The serial number is located on a label above the
toner cartridge. The Xerox Support Center or local representative telephone number is provided when
the device is installed. For convenience and future reference, please record the telephone number in the
space below:

Xerox Support Center or local representative telephone number:

#
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Control Panel: Touch Screen and Numeric
Keypad.

Document Feeder and Document Glass: Used
for scanning single or multiple documents. The
document glass can be used for scanning single,
bound, custom size or damaged documents.

Paper Trays 1 and 2: These trays are standard
on all models. Trays 1 and 2 are fully adjustable
and can be used for media sizes 5.5x8.5” to
11x17”(A5 to A3).

Paper Trays 3 and 4: These trays are high
capacity paper trays. Trays 3 and 4 are dedicated
trays used for 8.5x11” or A4 size media.

Bypass Tray: Used for non-standard printing
media.

Paper Tray 5: This is an optional high capacity
paper tray. It is a dedicated tray used for 8.5x11”
or A4 long edge feed size media. Optional kits
are available to accommodate 11x17”, A3,
8.5x14”, 8.5x11” or A4 Short Edge Feed (SEF)
media.

Tray 6 (Inserter): An optional paper tray for use
with the High Volume Finisher. It is used to insert
pre-printed sheets into copy sets. It is not part of
the printing process and cannot be used for
imaging.

Device Overview

High Volume Finisher: This optional finisher
collates, offsets, stacks and staples your output.
Booklet Maker, Tri-fold and Hole Punch kits can
be installed with this finisher.

Booklet Maker and Trifolder: These are optional
devices which can be installed with the High
Volume Finisher to staple and fold booklets or
leaflets.

Convenience Stapler: This optional device
provides manual stapling of up to 50 sheets. The
Convenience Shelf must also be fitted.

Offset Catch Tray: Delivers output collated or
uncollated. Each set or stack will be offset from
the previous to enable easy separation.

Basic Office Finisher: This optional device
stacks, collates, staples and offsets your output.

Advanced Office Finisher: This optional device
stacks, collates, staples and offsets your output.
Hole punch kits are also available for this finisher.

Document Glass Cover: This is a flat hinged
cover for the document glass. It is fitted instead
of the document feeder and is standard on some
configurations.
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Services and Options

Services and Options

There are a number of services and options available for use with your device. Many services are
provided as standard and simply require enabling or configuring with additional third party hardware.
Optional functions and kits are also available and can be purchased and installed. The options
available are dependent on your WorkCentre model.

WorkCentre Copier/Printer Models

Key:
e Standard 0 Optional - Not Available

WorkCentre

Description

35 40 45 55 65 75 90

Document Glass Cover a flat hinged cover for the document glass. | ®
Fitted instead of the document feeder.

Document Feeder feeds 75 (35 model only) or 100 single or double o ° ° ° ° ° °
sided documents. Documents from A5 to A3 (5.5"x8.5" to 11"x17")
can be fed. Fitted instead of the document glass cover.

Paper Trays 3 and 4 high capacity paper trays. o o o o ° ° °
Paper Tray 5 high capacity platform feed paper tray. o 0o 0o 0o o o o
Paper Tray 6 (Post Process Inserter) optional insert tray which can = o 0o 0o ) o o

be fitted with the High Volume Finisher.

Envelope Tray this tray is fitted instead of paper tray 2 to enable ° o o o o o o
envelope printing. Up to 55 #10 Envelope s (4.1"x9.5") can be
loaded in the tray.

Offset Catch Tray delivers collated or uncollated output. o o o o
Basic Office Finisher stacks, collates, staples and offsets your o o o
output.

Advanced Office Finisher stacks, collates, staples and offsets your | © ° o o o o
output. Hole punch kits are also available for this finisher.

High Volume Finisher collates, offsets, stacks and staples your = o o o o o o
output. Booklet Maker, Trifold and Hole Punch kits can be installed
with this finisher.

Hole Punch Kits available with the Advanced Office Finisher and o o o o o 0 o
the High Volume Finisher. The kits available are 2 Hole, 2 Hole
Legal, 3 Hole, 4 Hole or Swedish 4 Hole. Only one kit can be fitted at
one time.
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Getting Started



Services and Options

WorkCentre

Description

35 40 45 55 65 75 90

Convenience Stapler for manual stapling. The Convenience Shelf o o o ) ) o o
must be installed.

Convenience Shelf a shelf which can be installed on the left side of o o o o o o o
the device.

Stand a storage area which is fitted instead of trays 3 and 4. . . . .
Basic Fax Kit (Embedded) this kit enables a single fax line o o o o o o o
connection.
Extended Fax Kit (Embedded) this kit enables two fax lines to be o o o o o o o
connected.
LAN Fax® enables users to send faxes directly from their PC using R I N R T I
the print and fax drivers.

(¢} (¢} (¢} (¢} (¢} (¢} (¢}

Server Fax® enables users to send and receive hard copy faxes via a
fax server.

Internet Fax allows users to send or receive faxes over the internet o o 0 0 0 o o
or intranet.

Network Scanning Kit enables E-Mail and Workflow Scanning o o o o 0o o o
services. The mono-scanner is provided as standard.

Security kit provides additional security features, such as image U o o o o ° °
overwrite options.

Xerox Secure Access provides a card reading device to restrict o o o ) ) ) o
access to the device.

Color Scanner used to scan in color (factory fit). 0 o 0 o

Color Scanning Enablement kit a pin code is provided which = = = = o o o
enables color scanning capabilities.

Network Accounting enables the tracking of device usage for Print, ¢ 0 o o o o 0o
Copy and Scan jobs from multiple devices over the network.

Xerox Standard Accounting is an accounting tool which tracks the | ® . o o o o o
number of Copy, Print, Workflow Scanning, Server Fax and Fax jobs
for each user.

Foreign Interface Device enables the attachment of a third party o o o o o o o
access and accounting device, such as a card swipe or coin
operated unit.

a. Requires the Basic or Extended Fax Kit or a Third Party Fax Server to be configured and installed.
b.  Requires a Third Party Fax Server to be configured and installed.

WorkCentre Copier/Printer/Scanner Models

Xerox WorkCentre 5735/5740/5745/5755/5765/5775/5790 7
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Services and Options

Key:
e Standard 0 Optional = Not Available

WorkCentre

Description

35 40 45 55 65 75 90

Document Feeder feeds 75 (35 model only) or 100 single or double ° ° ° ° ° ° °
sided documents. Documents from A5 to A3 (5.5"x8.5" to 11"x17")
can be fed. Fitted instead of the document glass cover.

Paper Trays 3 and 4 high capacity paper trays. ° . . . . . .
Paper Tray 5 high capacity platform feed paper tray. 0o 0 0 0 o o o
Paper Tray 6 (Post Process Inserter) optional insert tray which can g o o o 0o o o

be fitted with the High Volume Finisher.

Envelope Tray this tray is fitted instead of paper tray 2 to enable o o o o o o o
envelope printing. Up to 55 #10 Envelopes (4.1"x9.5") can be
loaded in the tray.

Offset Catch Tray delivers collated or uncollated output. o o o o
Basic Office Finisher stacks, collates, staples and offsets your o o o
output.

Advanced Office Finisher stacks, collates, staples and offsets your o o o 0 o o
output. Hole punch kits are also available for this finisher.

High Volume Finisher collates, offsets, stacks and staples your = 0 0 0 o 0 0
output. Booklet Maker, Trifold and Hole Punch kits can be installed
with this finisher.

Hole Punch Kits available with the Advanced Office Finisher and o o o o o o o
the High Volume Finisher. The kits available are 2 Hole, 2 Hole
Legal, 3 Hole, 4 Hole or Swedish 4 Hole. Only one kit can be fitted at
one time.

Convenience Stapler for manual stapling. The Convenience Shelf o o o o o o o
must be installed.

Convenience Shelf a shelf which can be installed on the left side of o [ U U U U U
the device.

Basic Fax Kit (Embedded) this kit enables a single fax line o o o ) ) o o
connection.
Extended Fax Kit (Embedded) this kit enables two fax lines to be ° ° o o o o o
connected.
LAN Fax® enables users to send faxes directly from their PC using S I O e R I
the print and fax drivers.
Server Fax? enables users to send and receive hard copy faxesviaa | ® | ® | ¢ | * | * | * | ®
fax server.
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Services and Options

WorkCentre

Description

35 40 45 55 65 75 90

Internet Fax allows users to send or receive faxes over the internet o o ) ) ) ) )
or intranet.

Network Scanning Kit enables E-Mail and Workflow Scanning o o o o o o o
services. The mono-scanner is provided as standard.

Security kit provides additional security features, such as image [ o ° ° ° ° °
overwrite options.

Xerox Secure Access provides a card reading device to restrict o o o o o o o
access to the device.

Color Scanner used to scan in color (factory fit). o o o o

Color Scanning Enablement kit a pin code is provided which = = = = o o o
enables color scanning capabilities.

Network Accounting enables the tracking of device usage for Print, 0o 0 0 0 o o o
Copy and Scan jobs from multiple devices over the network.

Xerox Standard Accounting is an accounting tool which tracks the o o L] L] L] L] L]
number of Copy, Print, Workflow Scanning, Server Fax and Fax jobs
for each user.

Foreign Interface Device enables the attachment of a third party o o o o o o o
access and accounting device, such as a card swipe or coin
operated unit.

a. Requires the Basic or Extended Fax Kit or a Third Party Fax Server to be configured and installed.
b.  Requires a Third Party Fax Server to be configured and installed.
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Control Panel Overview

Control Panel Overview

(6]

2]

10

Services Home: Provides access to the services
available on the device.

Services: Returns the display to the previous
copy, fax, or scan feature screen when the Job
Status screen or Machine Status screen is
displayed.

Job Status: Use to check the progress of active
jobs, or display detailed information about
completed jobs.

Machine Status: Use to check the device status,
the billing meters, the status of consumables, or
print the user documentation and reports. Use

this button also when accessing the Tools mode.

Touch Screen: Use to select programing features
and display fault clearance procedures and
general device information.

Log In/Out: Use to enter log in details, and to log
out.

Numeric Keypad: Use to enter alphanumeric
characters.

Help: Displays help messages for device features.

©

1)

Ener@g aver

@)
Clear All
Interrupt Printing
toy
)

Interrupt Printing: Use to pause the job which is
currently printing, to run a more urgent copy job.

Start: Use to start a job.

Clear All: Press once to clear a current entry.
Press twice to return to default settings.

Stop: Stops the job in progress.

Energy Saver: Use to select energy saver mode,
perform a quick restart or to power down the
device.

Language: Use to select a different language for
the touch screen options.

Dial Pause: Use to insert a pause when dialing a
fax number.

‘C’ Cancel Entry: Cancels the previous entry
made on the Numeric Keypad.
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Power On and Off

Power On and Off

Power On

1. Ensure that your device is connected to a suitable N
power supply and that the power cord is fully plugged \
in to the electrical outlet of the device. ) ‘\% \/

2. Press the Power switch. The entire powering on process
(to power on all installed options) takes less than 3 Ny :
; ) y
minutes.
Power Off

1. Press the Power switch. The Power Down options are displayed:

o If Energy Saver is selected, the device will rcewon oo =
immediately enter the Power Saver Mode E— et S
. . . . Enorgy Saver Whan in Enargy Saver Mode. pross any kiy of iouch thit Scroon 10 wake th maching
appropriate to its configuration. ':J =
. . ) ‘Quick Aastart onds the culment sosEon, restans the machine ard any jobs n progross
e If Quick Restart is selected and confirmed the T R s e
Power Down

device will restart. Any copy jobs in the job list will e R T X
be deleted, print jobs in the job list are recovered.

e If Power Down is selected and confirmed the
device is powered down.
e If Cancelis selected the power down options will be cancelled and the device will be available
for use.
2. Select Power Down. A confirmation screen displays a warning that data may be lost if the device
is powered down.

Note: Confirming power down will result in the deletion of any jobs currently in the queue.

3. Select the Confirm button to power off the device.

The device will begin a controlled power down sequence. It remains on for approximately 45
seconds before switching off.
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Power On and Off

Energy Saver

The device is designed to be energy efficient and automatically reduces its power consumption after
periods of inactivity. The System Administrator can set up Energy Saver options. The Energy Saver
button on the control panel causes the Power Down options to be displayed. To activate Energy Saver
mode use the instructions below:

1. Press the Energy Saver button on the control panel.

The Power Down options are displayed.

2. Select Energy Saver. The device will immediately enter
Low Power mode.

If Sleep mode has been configured, the device will
then enter Sleep mode after a specified period of time.

The Energy Saver button is illuminated when the
device is in Energy Saver mode. A steady light indicates
the device is in Low Power mode. A flashing light
indicates the device is in Sleep Mode.

3. Tore-activate the device when in Low Power or Sleep mode, touch a button on the touch screen or
control panel. The device takes longer to recover from Sleep mode.

For information about setting up the Energy Saver options, refer to the Systerm Administrator Guide.
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Loading Paper

1. Open the required paper tray.

e  Paper Trays 1 and 2 are fully adjustable for all media sizes between A5 and A3 (5.5x8.5" and
11x17").

e Paper Trays 3 and 4 are dedicated paper trays which are set to hold either A4 or 8.5 x11" LEF
paper.

e Paper Tray 5 is an optional high capacity paper source. The standard tray has a single tray
which is set to A4 or 8.5x11" LEF. Two optional kits are available to allow Tray 5 to feed A3 or
11x17” SEF and A4 or 8.5x11” SEF.

e Bypass Tray accommodates most types of media in a range of sizes between A6 and A3 SEF
(4.25x5.5” and 11x17" SEF).

LEF = Long Edge Feed and SEF = Short Edge Feed.

2. Load paper. Paper must not be loaded above the maximum fill line.

If loading trays 1 or 2, make sure that the paper guides
are in the correct position for the paper size. Adjust
each guide by squeezing the clamp mechanism and
sliding the guide to just touch the edge of the media.

If loading the Bypass Tray, locate the media against
the front of the tray and move the rear guide to touch
the rear of the stack.

If loading Tray 5, press the button to open the door.
Wait for the paper tray to lower. The media required is
displayed on the screen. Place the media in the tray. Media must be positioned against the right
side of the tray.

3. Close the paper tray or tray door as required. The Bypass Tray remains open.

4. If the Paper Settings screen is displayed, select the size, type and color of the paper you have
loaded and select Confirm.

If the tray is a Dedicated tray the paper size and type specified on the touch screen must be
loaded and the Paper Settings screen is not displayed.

For information about loading special media, refer to on page 225 of
Specification information for the Xerox WorkCentre 5735/5740/5745/5755/5765/5775/5790 is
provided at
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Loading Documents

Loading Documents

Original documents can be loaded either into the
document feeder or onto the document glass.

1. Load your documents face up in the document feeder
input tray.
Adjust the guide to just touch the documents.

2. Lift up the document feeder. Place the document face
down onto the document glass and register it to the
arrow at the top right rear corner. Close the document
feeder.

Note: Original documents are only scanned once even
when several copies are selected.

Specification information for the Xerox WorkCentre
5735/5740/5745/5755/5765/5775/5790 is provided at
WWW.XErox.com.
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Making Copies

1. Load your documents face up in the document feeder input tray. Adjust the guide to just touch the
documents.

Lift up the document feeder. Place the document face down onto the document glass and register
it to the arrow at the top right rear corner. Close the document feeder.

2. Press the Clear All (AC) button once to cancel any previous screen programing selections.

3. Press the Services Home button and select the Copy  [ien 0
option. P 5
The Copy features are displayed. g - i i
L .:J @Maw @"‘"“ @mw
@ 100% 'J J;::w _) I IJ S

;) A% l:) 0l ;:;;u :‘) 22 ided |:) Hale Purch

*) et J Ulranpa _) 241 ddd 'J 1 Staghe
) o ';) e :) e

4. Select the required features using the touch screen:

G Reduce / Enlarge can be used to reduce or enlarge the image by 25 % to 400 % .

D Paper Supply is used to select the required tray and size of paper for the copy output.

2-Sided Copy is used to produce 1 or 2-sided copy output.
., Py P py outp

%‘% Copy Output is used to select collate, staple or fold options (depending on the finishing
= )-2)  device available).

5. Enter the copy quantity using the numeric keypad and press Start to scan the originals.
6. Remove the originals from the document feeder or document glass when scanning has completed.
The Copy job enters the job list ready for printing.

7. Select Job Status to view the job list and check the status of your job.

If your job is held in the list it requires additional resources to print. To identify the resources
required, select the job and select Job Details. Once the resources are available the job will print.

For information about additional Copy features, refer to on page 38 of

For information about copying an ID card, refer to on page 195 of

Xerox WorkCentre 5735/5740/5745/5755/5765/5775/5790 15
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Printing a Document

Printing a Document

1. Ensure that the correct Xerox print driver has been installed on your PC. To install the print drivers
refer to the System Administrator Guide.

2. Open the document to be printed. From your application, select File > Print and select the Xerox
device from the list of printers displayed.

3. To change the default printing properties click Properties.

The print driver has various tabs that contain options
and properties.

e  Use the Paper/Output tab to choose the type of

Faper/Output | Special Fages | Image Options | Layout/Watemark | Advanced

Sleetee o] eSeedpies
medigq, size and color and output choices such as (e Pk 8= [rsded P )
i i [Ff poer: C[] gapling=
2-sided prints. R ¥ [one [ ]
| Frinter Defautt Typs Ll D .,H",'e Punching:

e The Special Pages tab allows you to add covers,
inserts and exceptions. e

e The Image Options tab enables you to adjust the o ==
image quality. =

e  The Layout/Watermark tab has various options
to add watermarks to pages, change image

orientation (landscape or portrait) and enable B e ——
booklet and multi-up printing.

e The Advanced tab contains various font, document and printing options.

Choose the options required for your printing job and click OK to print the document.

4, The print job will be sent to the device and will appear in the Active Jobs list. To view the list at the
device, press the Job Status button on the control panel.

If your job is held in the list it requires additional resources or a passcode to print. To identify the
resources required, select the job and select Resources Required. Once the resources are available
the job will print. If a passcode is required, select Release and enter the secure passcode.

For information about additional Print features, refer to Printing a Document on page 144 of Print.
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Sending a Fax

1. Load your documents face up in the document feeder input tray. Adjust the guide to touch the
documents.

Lift up the document feeder. Place the document face down onto the document glass and register
it to the arrow at the top right rear corner. Close the document feeder.

2. Press the Clear All (AC) button once to cancel any previous screen programing selections.

3. Press the Services Home button and select the Fax o~ & 1 !

option. The Fax features are displayed. Wﬂ‘m‘m e

4. Enter the recipient’s fax number by:

e Keypad Dial - select the Enter Number area on
the touch screen and enter the number using the (@~
numeric keypad.

| || 2:5kdea scamning T | originat Type

e  Manual Dial - if a telephone handset is attached | 5. =
to the device, select the Manual Dial key and dial
the number using the handset or the numeric keypad.

e Speed Dial - select the Enter Number area and enter the 3 digit speed dial number, then
select the Speed Dial option.

e  Address Book - select the Address Book button to access the fax address book. Select an
entry from the Address Book to add to the Recipient list. Continue adding recipients as
required and select Close to return to the previous screen.

5. Ifrequired, select Add to add the number entered to the Recipient list. Enter additional numbers
as required. The fax will be sent to all the numbers in the Recipient list.

6. Select the required features for your fax job using the touch screen:

Dialing Characters are alphanumeric characters which have a specific fax function and can be
entered as part of the fax number.

Cover Letter allows you to send a fax with a covering letter.

2-Sided Scanning is used to select whether your originals are 1-sided or 2-sided.

Original Type is used to define the original document as text, text and photo, photo or halftone
photo.

] [

Resolution can be used to optimize the resolution settings.

7. Press Start to scan the originals and process the fax job. Remove the originals from the document
feeder or document glass when scanning has completed.

The Fax job enters the job list ready for sending.
8. Select Job Status to view the job list and check the status of your job.

For information about additional Fax features, refer to on page 66 of
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Server Fax

7.

8.

Load your documents face up in the document feeder input tray. Adjust the guide to touch the
documents.

Lift up the document feeder. Place the document face down onto the document glass and register
it to the arrow at the top right rear corner. Close the document feeder.

Press the Clear All (AC) button once to cancel any previous screen programlng selections.

-Dl'ullmmmrl...
Add

e,

Press the Services Home button and select the Server [J s 220
Fax option. The Server Fax features are displayed. lwi’

Enter the recipient’s fax number by:

e Keypad Dial - select the Enter Number area on
the touch screen and enter the number using the
numeric keypad.

= 1

e  Fax Directory - Touch the Fax Directory button, o ‘ ‘ F"’""’" ‘ ‘ e

select an entry from the Fax Directory to add to
the Recipient list.

Select Add to add the number to the Recipient list.
Select the required features for your fax job using the touch screen:

Dialing Characters are alphanumeric characters which have a specific fax function and can be
entered as part of the fax number.

2-Sided Scanning is used to select whether your originals are 1-sided or 2-sided.
= Original Type is used to define the original document as text, text and photo, or photo.

Resolution can be used to optimize the resolution settings.

Press Start to scan the originals and process the Server Fax job.
Remove the originals from the document feeder or document glass when scanning has completed.

The Server Fax job enters the job list ready for sending.

Select Job Status to view the job list and check the status of your job.

For information about additional Server Fax features, refer to on page 84 of

18
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Internet Fax

1. Load your documents face up in the document feeder input tray. Adjust the guide to touch the
documents.

Lift up the document feeder. Place the document face down onto the document glass and register
it to the arrow at the top right rear corner. Close the document feeder.

2. Press the Clear All (AC) button once to cancel any previous screen programing selections.

3. Press the Services Home button and select the [V v 0
Internet Fax option. The Internet Fax features are et _
displayed. [ e oo "

4.  Select New Recipients. B — j

5. Select To or Cc for the recipient using the drop-down R = : -
menu to the left of the entry box. g e )

6. Using the keyboard, enter the e-mail address. Qe ||| T [ |- l

e Up to 128 alphanumeric characters can be
entered.

e Todelete a character use the backspace key, or to clear the entire entry select the X button.
e Use the Keyboards... button to access additional language keyboards.

Select Add to add the e-mail address to the Recipient list. Continue adding e-mail addresses until
all the recipients have been added to the list, then select Save. All the recipients are displayed in
the Recipient list.

If an address book has been setup, enter the name of the recipient and select Search. A list of
matching recipients is displayed. Select the e-mail address required and select Add (To:) or Add
(Cc:) from the drop-down menu. The e-mail address is added to the recipient list. Multiple
recipients can be added to the Recipient list in this way. Select Close to exit.

7. Enter the Message, Reply To, From and Subject details as required.
8. Select the required features for your fax job using the touch screen:

Output Color is used to replicate the original colors or to change the output to black and white,
»  grayscale or color.

This feature may not be available on your device.

2-Sided Scanning is used to select whether your originals are 1-sided or 2-sided.
’a Original Type is used to define the original document as text, text and photo, or photo.

9. Press Start to scan the originals and process the Internet Fax job. Remove the originals from the
document feeder or document glass when scanning has completed.

The Internet Fax job enters the job list ready for sending.

10. Select Job Status to view the job list and check the status of your job.

For information about additional Internet Fax features, refer to on page 92 of
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Sending a Fax from the PC

Sending a Fax from the PC

1. Ensure that the correct Xerox print driver has been installed on your PC and the Fax from PC option
is available. To install the print drivers refer to the System Administrator Guide.

2. Open the document to be faxed. Click File > Print and select the Xerox device from the list of
printers displayed.
3. Select the Properties button to display the print driver printing preferences.

4. Select Fax as the Job Type on the Paper/Output
screen of the print driver.

The Fax screen will automatically open. This screen | = [sseesege | Insge trsns | o istemste | Averced

displays the recipients for the current fax. You can | &/%2%, g BN 5
.. Normal Print TR
now Add Fax Recipients or Add From Phonebook. [ |seoum e H L[] posting: ]
Delay Print. No Hole Punch o
Saved Job. ..

Output Destination:
| Automatically Select ~|

=4 i L
Sl 5
BIRE C ok 1= ) [ ]
5. To add a new recipient select the Add Recipient button. Fax 5l

6. Input the name and fax number of the recipient. Complete the || Fesierts |cover sheet | options

additional information. ﬂ

Select the Save to Personal Phonebook option if you want to T e T
add the recipient to your Personal Phonebook. )

The Fax window has various tabs that contain options and

properties.
e Use the Cover Sheet tab to add a covering letter to your
fax.

e Use the Options tab to enable a confirmation sheet,
choose a specific send speed or select the resolution for

the fax. You can also select the Send Time option to entera || ¢ >
specific time to transmit the fax. 23 8%
7. Choose the options required for your fax job and click OK to
send the document. Your fax will be submitted to the device job

list ready to be transmitted.

For information about additional Fax from PC features, refer to Fax from PC Options on page 103 of
Fax.
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Workflow Scanning

Workflow Scanning allows the user to scan a hard copy original and convert it into an electronic file.
The file is placed into a specified filing location on a networked server, workstation or the device hard
drive. The settings used for scanning the original are stored in a template.

1. Load your documents face up in the document feeder input tray. Adjust the guide to touch the

documents.

Or......

Lift up the document feeder. Place the document face down onto the document glass and register
it to the arrow at the top right rear corner. Close the document feeder.

2. Press the Clear All (AC) button once to cancel any previous screen programing selections.

3. Press the Services Home button and select the CYR S B, reaonen ) by |
Workflow Scanning option. The Workflow Scanning Dostnaon et
features are displayed. | -rcomasncxtomsa o s _|

4. Select a Template for the job from the templates T —
displayed in the list. e
All the current settings are changed to the settings in | L2220 ,
the template. @D:..,,m‘ Hj Bsed ‘ H__,J D.._g._n.,.‘ Hg e

5. Select the required features for your scanning job
using the touch screen.

If required, modify the template settings from the options on the Workflow Scanning, Advanced
Settings, Layout Adjustment and Filing Options tabs:
@ Output Color is used to replicate the original colors or to change the output to black and white,
grayscale or color.
This feature may not be available on your device.
2-Sided Scanning is used to select whether your originals are 1-sided or 2-sided. The second side
can be rotated.
E Original Type is used to define the original document as text, text and photo, or photo.
Scan Presets is used to set the scan settings to suit how the scanned image will be used.

6. Press Start to scan the originals and process the Workflow Scanning job. Remove the originals
from the document feeder or document glass when scanning has completed. The Workflow
Scanning job enters the job list ready for filing. The scanned images are then filed to the location
specified on the template ready for retrieval by the user.

For information about additional Workflow Scanning features, refer to on

page 115 of
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Sending an E-mail

1. Load your documents face up in the document feeder input tray. Adjust the guide to touch the
documents.

Lift up the document feeder. Place the document face down onto the document glass and register
it to the arrow at the top right rear corner. Close the document feeder.

2. Press the Clear All (AC) button once to cancel any previous screen programing selections.

3. Press the Services Home button and select the E-mail [ . e
option. The E-mail features are displayed.

4, Select New Recipients.

5. Select To, Cc or Bec for the recipient using the drop-
down menu to the left of the entry box.

Using the keyboard, enter the e-mail address.

e Up to 128 alphanumeric characters can be
entered.

e Todelete a character use the backspace key, or to clear the entire entry select the X button.
e Use the Keyboards... button to access additional language keyboards.

Select Add to add the e-mail address to the Recipient list. Continue adding e-mail addresses until
all the recipients have been added to the list, then select Save.

All the recipients are displayed in the Recipient list.

If an address book has been setup, enter the name of the recipient and select Search. A list of
matching recipients is displayed. Select the e-mail address required and select Add (To:), Add (Cc:)
or Add (Bcc:) from the drop-down menu. The e-mail address is added to the recipient list. Multiple
recipients can be added to the Recipient list in this way. Select Close to exit.

6. Enter the Message, Reply To, From and Subject details as required.

7. Select the required features for your e-mail using the touch screen:

| Ovigisal Type |A 15 scam presets |.
Photo & Tost Sharng & Prining

@owcor || (228, .
Auta Detect 1-Sided

(P Output Color is used to replicate the original colors or to change the output to black and white,
grayscale or color.

-

This feature may not be available on your device.

2-Sided Scanning is used to select whether your originals are 1-sided or 2-sided. The second side
can be rotated.

Original Type is used to define the original document as text, text and photo, or photo.

@[

Scan Presets is used to set the scan settings to suit how the scanned image will be used.

E

8. Press Start to scan your originals and process the E-mail job. Remove the originals from the
document feeder or document glass when scanning has completed.

The E-mail job enters the job list ready for sending.

9. Select Job Status to view the job list and check the status of your job.
For information about additional E-mail features, refer to on page 163 of

22 Xerox WorkCentre 5735/5740/5745/5755/5765/5775/5790
Getting Started



Saving Jobs for Reprinting

Saving Jobs for Reprinting

9.

10.

Load your documents face up in the document feeder input tray. Adjust the guide to just touch the
documents.

Lift up the document feeder. Place the document face down onto the document glass and register
it to the arrow at the top right rear corner. Close the document feeder.

Press the Clear All (AC) button once to cancel any previous screen programing selections.

Press the Services Home button and select the Copy
option.

The Copy features are displayed.

Program the required job features.

O=  Om T O

Select the Job Assembly tab, and then Save Job for Reprint.
Select the option required: e - 1
e Copy & Save is used to store the job and printa | @)=« P s owwr s
copy of the job. o e —
e Save Only stores the job without printing. Fraes w0
Select a folder location to store the job. — o
Select New Job Name and enter a name for the job i [FP a0
using the keyboard.

Select Save to save the job name and return to the previous screen.
Press Start to run the job.

The job is scanned and saved with the name entered, in the folder selected. If Copy & Save was
selected, a copy of the job is also printed.

Jobs can also be saved using the print driver options or Internet Services. For additional information
about Saving Jobs for Reprint, refer to Saving a Job on page 181 of Save and Reprint Jobs.
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Reprinting Saved Jobs

Reprinting Saved Jobs

1. Press the Services Home button.
2. Select the Reprint Saved Jobs option.
Folders containing the saved jobs are displayed.

3. Select the folder required. If necessary, use the scroll
bar to access all the folders.

A list of the jobs in the folder is displayed.

2 Folder A

4 Folder B

3 Folder C

File Folder Management_

4, Select the job and select the print or save option required:

- int
&mku

e  Printis used to print the selected job using the
currently saved print settings.

o If print settings are changed from those stored
with the original print job, Print and Save is used
to print and then store the selected job with the
new settings.

e Save is used to save the selected job without
printing. The job will be saved in place of the
original job with any new settings selected.

If the job settings require changing prior to printing
the job, select the Settings option. Select the options

required and then select Print, Print and Save or Save.

5. If the job is a secure job, enter the passcode required
and select Print Job.

6. Select Job Status to view all the job lists and check the
status of your job. For further information, refer to Job
Status on page 233 of Machine and Job Status.

(] appie

DOMMYY 00:0000PM 10

~
-

J banana

COMMAYY 00:00:00AM =

DOMMYY 000000PM 100

2-Sided Printing

=
.mm

"" 1 Sided

@

. 2 Sided, Fiotats Sid . 1 Suple
.

Jobs can also be reprinted using Internet Services. For additional information about Reprint Saved Jobs
features, refer to Reprinting Saved Jobs on page 184 of Save and Reprint Jobs.
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Log In / Out

Log In / Out

If Authentication or Accounting has been enabled on the device, you may need to log in before using
some or all of the services. A picture of a lock on a button indicates that you must log in to use that
service.

1.

To log in select the Log In/Out button on the control
panel. Selecting a locked service will also prompt you
to enter a log in name and password.

Use the keyboard to enter your User Name.

If a password is required, select the Next button and
use the keyboard to enter your Password.

Select the Enter button.

If an accounting system is in use on the device, you
may also need to enter additional information, for example a User ID or Account ID. If a Foreign

Device Interface (FDI) is installed, you are prompted to access via the device installed, for example
a card reader or coin slot.

Your user details display in the User Details area on the right side of the message display.

To log out, select the Log In/Out button again or select the User Details area and select Log Out
from the drop-down menu.

A confirmation screen is displayed, select Log Out or Cancel.
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Enhance Productivity

Your device is a powerful multi-functional device with many digital functions integrated into one sleek
system. It is designed to support large workgroups in different office environments. You can do more
with less and streamline your workflow with these productivity enhancing features, for example:

e  Online address books
e  Customization to meet own work processes

e  Powerful documentation features for example, Booklet Creation, Special Pages, Build Job and
Annotations

To maximize job productivity, use the Job Status button to access the Active jobs list and manage your
jobs. If a job is urgent, use the Promote option to prioritize your jobs.

If a job is Held in the list, it may require additional resources or a secure code to print. The reason for
the held status is displayed on the Job Progress screen. Once the requirement has been met or the
correct secure code entered, the job is released for printing.

For further information about customizing or using your device refer to on page 244 of
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Maintenance and Consumables

There are several consumables on the device that need replenishing or replacing, such as paper,
staples, and customer replaceable units. To place an order for Xerox consumables, please contact your
local Xerox Representative giving your company name, product number and the machine serial
number.

For information about locating the serial number, please refer to on page 236 of

There are 5 replaceable units on the device:
e  Xerographic Module

e Toner Cartridge

e  Fuser Module

e Ozone Filter

e  Waste Toner bottle

The device will display a message on the touch screen when any of the units need to be reordered. This
message is a warning that the unit is nearing the end of its life. Only replace the unit when a message
actually instructs you to do so.

To replace a Customer Replaceable Unit, follow the instructions on the touch screen or use the
instructions provided with the consumable.

If your device is equipped with a finisher, or a convenience stapler, you will be required to replace the
staple cartridge or cartridges when the device displays a message instructing you to do so. If your
finisher has the optional hole punch unit, you will also be required to empty the hole punch waste
container when prompted by the device.

Performing regular cleaning activities ensures the device is kept free of dust and debris. The device
covers, control panel and touch screen should all be cleaned using a soft lint-free cloth, lightly
dampened with water. Xerox Cleaning Fluid or Anti-Static Cleaner can be used to clean the document
glass, but must be applied using a cloth and not poured directly on the document glass. Remove any
residue with a clean cloth or paper towel.

For further information on maintenance tasks, refer to on page 280 of
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Troubleshooting

Troubleshooting

A variety of situations can affect the quality of your output. The animations and fault messages on the
device help you to locate and resolve a problem easily. Some problems can be resolved by restarting
your device. If after rebooting your device the problem has not been resolved, have a look at some of
the areas below to identify solutions.

Problem Solution

The device will not power on e Check to see that the device is not in Energy Saver Mode as
indicated by the green light on the control panel. Touch the user
interface screen to re-activate.

e Check to see that the power cord is correctly inserted.

Documents will not feed through the | e Ensure that you have selected the correct service e.g. Copy, Fax,
document feeder Workflow Scanning.

e Ensure that all staples or paper clips have been removed from the
originals.

e Ensure the document feeder is not overloaded, a maximum of 75
documents (35 model) or 100 documents (other models) can be

loaded.
e Ensure that the edge guides are adjusted to touch the sides of the
originals.
The device will not print from a e Make sure that an active network cable is connected to the
workstation workstation.

e Check that the Network Setup is correct. For further information
refer to the System Administrator Guide.

Cannot send an E-mail e Check if the device is connected on the network.

e Check that E-mail is enabled. For further information, refer to the
System Administrator Guide.

Avoiding paper jams o If the paper curls excessively, flip the paper over in the applicable
paper tray.
e Use paper from a fresh package.

Cannot fax a document e Ensure the Fax service is enabled.

e Ensure your device is connected to a telephone socket if using Fax,
or the network for other fax services.

The job has been scanned or sent o Select the Job Status button and check the status.

from the PC but does not print o If the job is Held, select the job in the list and use the Required
Resources option to identify the resources required to enable the
job to print.

o If the job is a Secure Print job, select Release and enter the
passcode required.

For further information about problem solving, refer to Troubleshooting on page 284 of General Care
and Troubleshooting.
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Troubleshooting

Paper and media jams happen for a variety of reasons. When a jam occurs, the device presents
instructions on the screen explaining how to remove the jam.

Any printed sheets removed will automatically reprint once the paper jam is cleared.

1. The fault screen will indicate the location of the jam. Use the green handles and knobs indicated
in the instructions displayed on the screen to remove the jammed paper.

2. Ensure that all jam clearance handles and levers are returned to their correct positions. The red
flashes behind the jam clearance handles and levers should not be visible.

Jam Clearance areas vary depending on your device model and configuration.

1. Remove all the documents from the document feeder and document glass as instructed.

2. Re-order the documents as at the start of the job and reload. The documents will be recycled
automatically to recover the job.

For further information and help refer to on page 284 of
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Help

When using your device, detailed and timely help is available at your fingertips. You can access Help
information and tips from a variety of sources.

Press the Help button at any time to access the online help screens. Messages, screen instructions and
graphics provide additional information.

The user documentation and various reports can be accessed and printed at the device.

1. Press the Machine Status button and select Machine Information.
2. Select Information Pages.

A list of the reports and documentation available is displayed.
3. Select the report or document required and select Print.

Most answers to your questions will be provided by the documentation that is supplied with the device.

e User Guide - the user guide is divided into several sections and provides instructions and
information about all the features on the device.

e Posters - the posters overview all the basic functions of the device and can be printed and
displayed next to your device.

e System Administrator Guide - provides detailed instructions and information about connecting
your device to the network and installing optional features.

The user documentation can be accessed and printed at the device, as described above. Other
documents are either provided on disc or can be downloaded from the Xerox website.

Faults on the device can be accessed at the device. The screen displays fault listings, and the device
error logs. The fault page is separated into three options:

e AllFaults
e Active Messages
e Event Log

To access the Faults page: Press the Machine Status button, touch Faults and select the required
option.
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Help

Click ? on the print driver screen or press [F1] on the PC keyboard for information on the displayed print
driver screen.

To access Internet Services, open the web browser from your workstation. In the URL field, enter http://
followed by the IP Address of the device and press Enter to view the Home page.

Click Index to view the contents of the Internet Services site.

Click Help to take you to the Xerox online support web site.

To find out the IP Address of your device, print a configuration report. For instructions, refer
to on page 236 of

For any additional help visit our customer web site at or contact the Xerox Support
Center quoting the machine serial number.

To locate the machine serial number and contact information, press the Machine Status button on the
control panel. The Customer Support information and the Machine Serial Number are displayed on the
Machine Information tab.
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Help
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Free Manuals Download Website
http://myh66.com
http://usermanuals.us

http://www.somanuals.com

http://www.4manuals.cc

http://www.manual-lib.com

http://www.404manual.com

http://www.luxmanual.com

http://aubethermostatmanual.com

Golf course search by state

http://golfingnear.com

Email search by domain

http://emailbydomain.com

Auto manuals search

http://auto.somanuals.com

TV manuals search

http://tv.somanuals.com



http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/
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